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Disclaimer and risk warnings

All contents of this manual are neither an endorsement, nor a solicitation of any sort, and
cannot be considered as a promotional offer. All information you receive is unsolicited, private
encoded communications of privileged, proprietary, and confidential information for you only
and by purchasing the given product you agree to keep this information private, confidential,
and protected from any disclosure. You also agree to indemnify and hold harmless the authors
of this product, their employees, contractors, and service providers. Should any of the practices
described herein turn out to be unlawful in any jurisdiction, individuals pursuant to its
legislation should restrain from any intentions or attempts to apply them in any manner, either
personally or in partnership with other individuals or entities. Unauthorized copying and
distribution of all or any parts of this manual or product are strictly prohibited and will result in
civil liability and criminal charges brought against the violators and their aides.

U.S. Government Required Disclaimer - Commodity Futures Trading Commission. Futures and
Options trading has large potential rewards, but also large potential risk. You must be aware of
the risks and be willing to accept them in order to invest in the futures and options markets.
Don't trade with money you can't afford to lose. This is neither a solicitation nor an offer to
Buy/Sell futures or options. No representation is being made that any account will or is likely to
achieve profits or losses similar to those discussed on this web site. The past performance of
any trading system or methodology is not necessarily indicative of future results.

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN
LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT
REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, THE
RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN
MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL
ARE ALSO SUBIJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT.
NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE
PROFIT OR LOSSES SIMILAR TO THOSE SHOWN.
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1. Foreword

Thank you for purchasing Forex Sensation. This manual will help you install, activate,
and use your software with maximal profit and minimal trouble.

With the purchase of your Forex Sensation, you gained access to our members’ area,
with this manual and all required files available for download there. It is of a high importance
that you download all required software files to your computer and save them in a handy place
to be able to use them during the installation process. The Forex Sensation can be installed in
two different ways — to facilitate finding the necessary files for both methods you can check
with this list:

For the 1% method:

ForexSensationSetup.exe

For the 2" method:
ForexSensation.ex4

ForexSensation.dll

You can choose only one method, which suits you better. It is also essential that you
have these files to proceed with setting up your Forex Sensation copy. We recommend saving
them to your desktop for your convenience.



2. Getting Started

The first thing you need to do after downloading the files is decide which broker you are
going to trade with. In this manual, we will describe the installation on the example of
MyFxChoice, but should you choose a different broker, don’t worry, as Forex Sensation works
fine with other brokers too, and the installation is rather similar.

Before running Forex Sensation on a live account, we recommend that you get
acquainted with it on a demo account beforehand. The subsequent pages of this manual
describe how to register a demo account first.

To open a DEMO account with MyFxChoice, please, go to the following URL:
https://my.myfxchoice.com/registrationDemo/, submit all the requested information in the
registration form, select “Forex Sensation” in Account field and then click the “Submit” button,
as shown below:

@
Fx‘ h OI ce Please click here to go to our homepage

Wise choice to trade

Open Demo account

Email *

Full name *

+ (

Country *

Country -
Account
Forex Sensation -

Currency

-

V| | agree to receive news and promotional material from FX Choice Limited

Submit
You can select any MT4 option in the Account section.

Register Live Account at MyFxChoice and get 15% Deposit Bonus for Forex

Sensation!

Next, you will receive a confirmation email from MyFxChoice, with your demo account login
details and a link to the page where you can download the MyFxChoice MetaTrader4 platform.


https://my.myfxchoice.com/registration/?ib=16663
https://my.myfxchoice.com/registrationDemo/
https://my.myfxchoice.com/registration/?ib=16663
https://my.myfxchoice.com/registration/?ib=16663

To begin with the installation, click on the MetaTrader4 download link in the body of your
email.

As soon as the page loads on your screen, a dialogue box will appear prompting you to save the
setup file to your computer. You can Save it to your computer by clicking on “Save File”:

-

Opening fxchoicedsetup.exe @
You have chosen to open

B | fachoicedsetup.exe
which is & Binary File
from: http://myfechoice.com

Would you like to save this file?

ﬁl Save File ‘ [ Cancel

If you decide to save it to your computer, you will also have to select a directory where to save
the setup program. For your convenience, we recommend you to save it to your Desktop:

——— -
-
(@) Enter name of file to save to... P | — @
_ —
@UF!DESHDF}‘ v|‘?||,‘ ch Desktap o
Organize = Mew folder ﬁj - .;@;.
4.7 Favorites — Libraries
Bl Desktop | Systern Folder E
4 Downloads -
5l Recent Places |5 Homegroup
* Systern Folder
4 Libraries
Nj Day Support
> Ef| Documents ‘_?‘ Systemn Folder
4 J Music -
» || Pictures . Computer
> B videos =SS System Folder
File name: fxchoicedsetup.exe -
Save as type: IBinar}r File vJ
~ Hide Folders | sae || cance |

After the installer file downloads to your computer, you will most likely be asked for a
permission to run it. This is the Windows built-in security, and you should confirm any
messages for the program to be able to install correctly.



You might also see warnings from your antivirus system — since such software is heavily coded
to prevent reverse engineering, it might be taken as a virus by some security systems, which are
for some reason unable to detect the difference between such security measures and true
malware. What should they do if they see such warnings? That instruction needs to be
included.

During the installation process you should be prompted consequently to the below windows.

3 FX Choice MetaTrader 4 Setup (32 bit) |
MetaTrader FXChoice
Client Terminal Wise choice to trade

Welcome to FX Choice MetaTrader 4 Setup!

The dient terminal is designed for performing trade operations in different finandal markets. The
terminal also offers wide analytical possibilities and supports various tools for conducting
technical analysis.

Program contains all the necessary tools for developing, testing and running programs faor
automated trading (Expert Advisors), These programs are written in the built-in language, using
which you can also create custom indicators and scripts.

By installing this program, you agree to all the conditions of the License Agreement., Click Mext'
to continue with the Setup program or dick 'Cancel if you disagree with License Agreement.

Read License Agreement...

Unathorized reproduction or distribution of this program, or amy portion of it, may result in severe dvil and
ariminzl penalties, and will be prosecuted to the maximum extent possible wnder law,

F¥ Choice Limited

< Back Meat = ][ Cancel

Click “Next >”.



Then you will be prompted to select the path into which you wish to install your MetaTrader4
platform and the name of the Start Menu program group. We recommend that you leave it
default, which is the most convenient path option.

[ FX Choice MetaTrader 4 Setup (32 bit) ==
MetaTrader FXChoice
Client Terminal Wi chokee o trade

Select the destination folder where you want to install FX Choice MetaTrader 4. Toinstall to a
different location, dick Browse, and select another folder.

Installation folder: :\Program Files\FX Choice MetaTrader 4 Browse...

Select the Start Menu program group in which you would like Setup to create the shortouts.

Program group:  FX Choice MetaTrader 4

Select the additional tasks you would like Setup to perform while installing.
Create a desktop shortout

Launch program after successful installation

F¥ Choice Limited

<Back | Ned> | | Cancel

Important: Make a note of the installation folder path — you will need to know the location
later in order to install Forex Sensation.

Click “Next” after you have decided on your path, and the setup program will place all the
necessary MetaTrader4 files into the selected directory. After the installation is finished, click
on “Finish”, and run your MetaTrader4.

When MetaTrader4 starts up for the very first time, you will need to log in with your Demo
account details that you have received in your MyFxChoice registration email. We highly
recommend noting them down to be able to access your demo account later from other
platforms.



https://my.myfxchoice.com/registration/?ib=16663

X F¥ Choice MetaTrader 4 - USDCHF, M1

- By~ (R € Gy ®), | 1=k @ |8 Expert Advisors I8 ke
Market Watch: 16:24:53 = —
) 5 USDCHF, M1 c
Symbol Bid Ask =
¥ UsDC... 08921 0.5925 |=
&+ GBRU.. 16339) 16342 FX Choice MetaTrader 4 @
4 EURL... 14451 1.4453
& USDIPY | 8319 83.22 = E%
I f.!i_.‘?. Authorization allows to get access to the trade account ==

¥ UsSDC.. 09620 059624 1
4 AUDU.. 10515 1.0513
& EURG... 0.8543 0.55848 Login: | &051| -

¥ EURA... 13736| 13748
i Password: essesess

& FLIRC
Symbels | Tick Chart | ] Server:  FXChoice-Demo A

Navigator x _ Save account information .
MetaTrader 4
o @ Accounts [ Login l I Cancel

+_f Indicators
+'% Expert Advisors
w1 [l Custorn Indicators

. L Scripts

Normally, you will be presented with a login screen immediately upon opening your trading
platform for the first time. Should you need to log in again, you can click on “File” > “Login”.
Here, enter the login and password for your demo account, select the FXChoice-Demo server
option, and click on “Login”. Make sure that you select the correct server, as the demo login
credentials issued to you earlier will only work in conjunction with the FXChoice-Demo server.
After you click on the “Login” button, your account will be logged in automatically, and your
MetaTrader platform will be ready to go.

After doing that, please, be sure to CLOSE the MetaTrader4 window. All installations should be
performed when your trading platform is closed, otherwise you might face a series of problems
in the installation process.



3. Step 1 - Installing Forex Sensation

1°* Method

This is the recommended and most convenient method to install Forex Sensation. To install it
this way you will need only one file:

- ForexSensationSetup.exe

First of all, you will need to find the ForexSensationSetup.exe file on your computer and run it
by double left-clicking on the respective file icon:

d

Forex5ensatio
m.exe

The first window of the installation will prompt you to agree to the Software License
Agreement. Confirm it by clicking on “l agree”:

@ Forex Sensation v.1.00 EI = I@
License Agreement F

Pleasze review the license terms before installing Forex Sensation. @

Press Page Down to see the rest of the sareement,

|£x|| contents and provisions of the Forex Sensation web-resource and intellectual &
property preducts are nether an endorsement, nor a selicitation of any sort, and cannet

be considered as a promotional offer. All data you receive is unsolicited, private -E|
encoded communications of privieged, proprietary, and confidential information for you —
onhy and by utilizing the given product vou agree to keep this information private,
confidential, and protected from any disclosure. ou also agree to indemnify and hold
harmless the authors of Forex Sensation, their employees, contractors, partners, and
service providers. Should any of the practices described herein turn out to be unlaw ful

in any jurisdiction, individuals purguant to its legizlation ghould restrain frem any

intentions or attempts to apphy them in any manner, either personally or in partnership -

If you accept the terms of the agreement, dick I Agree to continue, You must accept the
agreement to install Forex Sensation.

[ I Agree ] [ Cancel ]

At the next stage, the setup program will try to find any existing copies of MetaTrader4 on your
computer, and provide you with their list. If you do not see your MetaTrader4 on the list, you
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can add it manually, by clicking on “Add”, and selecting the folder in which it is located, in our
case — FX Choice MetaTrader 4. Please bear in mind that it is crucial to select only the root
folder of your MetaTrader4 — not the experts or libraries folders.

@ Forex Sensation v.1.00: Terminals o || B | ER
License Ag _ ‘
Please revi @ Browse For Folder IEI ) @
Select MetaTrader folder
The Farex add andfor
delete fald
- Press “Ad 4| || FiX Choice - MetaTrader 4 -
- Select Mel -
- Select Mgl . config >
C:\Progra > experts \ ‘?‘
[C: Prograi > LU history o

Add
| Languages \
Delete
o =
 maillbox \
> profiles

-

Souinrs

Make Mew Folder l [ Ok J[ Cancel l

[ <Back | Insial tCancEI

After you add your MetaTrader4 folder to the list, make sure it is hlg\llghted and displayed in
the top field as well:

@ Forex Sensation v.1.00: Terminals

f=)l & s
License Agreement ‘
¥o

Flease review the license terms before installing Forex Sensation,

The Forex Sensation robot will be installed into the folders shown below, You may add and/for
delete folders as required.

- Press "Add” to individually choose each MetaTrader folder,

- Select MetaTrader and press ™..." to choose Metatader root folder,

- Select MetaTrader and press Telete” to remove it from the list,

Ci\Program Files'\FX Choice - MetaTrader 4 @
C:\Program Files\FX Choice - MetaTrader 4 - Add

[ < Back ][ Install ] [ Cancel ]

Finally, click on “Install”, and you will see the “Installation was completed successfully”
window.
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https://my.myfxchoice.com/registration/?ib=16663

=0 ECH

@ Forex Sensation +.1.00

Forex Sensation Installed
‘ Successfully

User Guide has been saved to your Windows Desktop,
Please review the User Guide before continuing,

View User Guide

ncel

o

Just click on “Close” at the bottom of the window and you are ready to proceed to the second

step.
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2" Method

Important: Use the second method of the Forex Sensation installation only if the first method
doesn’t work or produce errors. Though it is a classic method of installation, it is more
complicated and is used only in cases where the automated setup doesn’t work.

To use this method, you should find the following two files on your computer:
Forextenzation.exd

EX4 File e ForexSensation.dll
281 KB

Do not open any of these files — they are not executable and should be pasted according to the
following instructions:

&

Step 1. First of all, you need to copy the ForexSensation.ex4 file into the necessary folder. You
can begin by right-clicking on the file icon and selecting “Copy” in the drop-down menu that

will pop up: V4

Cut

Copy x
%

Create shortcut
Delete

Rename

Properties

Step 2. Next, you will have to remember the folder where your MetaTrader4 is installed. For
MyFxChoice, with the default installation options you can find it at C:/Program Files/FX
Choice MetaTrader 4/. This path varies with different brokers, so we highly recommend noting
down the path during the respective stage of your MetaTrader4 installation process.

Also, in some cases, and in particular, if you are running a 64-bit Windows version, the
Program Files folder might look like “Program Files(x86)” or “Program Files(x32)".

If you experience any problems locating your platform, you can hold your mouse cursor over
the MetaTrader4 icon for a few seconds, and a pop-up will show you the correct path.

VIt rat erts e j A
| Location: terminal (C:\Program Files\FX Choice MetaTrader 4)
Step 3. Now that you have found the necessary path to your MetaTrader4 folder, you can open
“My Computer” or “Computer” for Windows 7 or Vista. That should open the built-in
Windows Explorer application, which allows you to browse your computer files system.
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https://my.myfxchoice.com/registration/?ib=16663

OQ |;‘.i » Computer »

Organize + Systemn properties Uninstall or change a program

4 Hard Disk Drives (2)
Local Disk (C:)

[ Favorites

Ml Desktop
& Downloads
] Recent Places

- H
g/ 359 Gifree of 51.8 GB

4 Devices with Removable Storage (1)

. Libraries 4

= -
=) Documents $ thlw Drive (E:)

A Music

On this example, you can see how we proceed to the *

Map network drive

- | 4 | | Search Computer

Open Contrel Panel

Local Disk (Ov)

=
S 170 GB free of 180 GB

‘experts” folder by double-clicking on all

subsequent folders specifgd in the path we determined earlier.

Step 4. First double click on Local Disk (C:).

Step 5. then click on Program Files:

N

@U'|£ + Computer » Local Disk (C:) » \
Organize - = Open Include in library - Share with « Nfilder

- Favorites Perflogs |

Bl Desktop l File folder " [

4. Downloads

=l Recent Places i Users

flll Filefolder ‘

4 Libraries cports.zip

| Documents E WinRAR ZIP archive

- E2 2 VWD

= | "f| | Search Local Disk (C:) o |

Program Files
File folder

Windows

File folder

Step 6. Then click on the FX Choice MetaTrader 4 folder:

\

@le . v Computer » Local Disk (C:)  » Program Files »

Organize « 7 Open Include in library + Share with = MNew folder
[ Favorites 1 Adobe i
B Deskiop (] Filefolder \ i
& Downloads
:i‘- Recent Places Common Files \
il File folder I
- Libraries
‘“aj DVD Maker |
] Documents | File folder |
A Music :

14

Search Program Files i |

-4

Avira
File folder

DIFX
File folder

m

FX Choice MetaTrader 4
File folder




Step 7. After you get to the MetaTrader4 folder, it is very important that you open the
“experts” folder.

, \

@Uv| , <« Local Dh:) » Program Files » FX Choice MetaTraderd »
Organize = 7 Open In ein library = Share with » New folder 5- » [ l@l
[ Favorites Ng deleted 3
B Desktop { ‘ File Toldgr ] . Filefolder
& Downleads ‘
=] Recent Places experts i history
| File folder § File folder
4 Libraries
‘raj Languages Links
] Documents | File folder b} Ficfolder E
J‘. Music
=] Pictures logs | mailbox

Step 8. Here, you can paste the file by right-clicking on any empty space and selecting “Paste”
in the dropdown menu.

] ===
@le ., « Program Files » FX Choice MetaTraderd » experts » - | 3 | Search experts o
Organize « Include in library = Share with « New folder =~ [0 n@n
[ Favorites files include F
Bl Desktop l . Filefolder | File falder
& Downloads
il Recent Places indicators | libraries
[ | File folder W A
7 Libraries Sort by 3
- logs
j Documents File folder Group by 3
&' Music Refresh
] Pictures samples Customize this folder...
B Videos File folder |
Paste T
#d Homegroup templates Paste shortcut
| File folder Undo Delete Ctri+Z
L™
1% Computer MACD Sample.excd Share with »
‘ EX4 File
€ Network KB Mew b
Moving Average.exd .
] EX4 File Properties

15



Step 9. After you paste the ForexSensation.ex4 file into the “experts” folder, in the same folder

(i.e. the experts folder) locate the “libraries” folder.
[ [-50- esal]
@Uv| . € Program Files » FX Choice MetaTraderd4 » experts » - | 3 | | Search experts o
Organize » = Open Include in library « Share with + New folder ﬁi ~ [ Iﬁéﬁl
- Favorites files include
B Desktop [ File folder | File folder
4 Downloads
5| Recent Places indicators libraries
File folder File folder '
= Libraries \
j logs presets \
] Documents File folder . File folder
J Music \

Click on the “libraries” folder, and locate the ForexSensation.dll file and repeat the previous
instructions from Step 1 to Step 8 in relationship to the ForexSensation.dll file.
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4. Step 2: MetaTrader4 Configuration

Once you have finished installing the Forex Sensation files, the next thing to do in MetaTrader4
is to go to the Tools —> Options menu:
Toolz | ‘window  Help

Mew Order F9
5:9 Hiztary Center F2
5 Global Variables F3

<:> ketalluotes Language Editor Fa

Q«_ Optionz Ctrl+0

This step is critically important for backtests as well as for saving much trouble with setting up
your software copy every time you run it.

All you have to do here is click on the Expert Advisors tab and ensure that the boxes are
checked exactly as shown below:

| Server | Charts | Objects | Trade | Expett Advisors | Email | Publisher | Events |

Enabl Expert Advisors (except for Custom Indicators and Scripts)
Allowfive trading

[ Ak manual corfimmation
AllowDLL imports

[] Borfirm DLL function calls
Allow

isable experts when the account has been changed

isable experts when the profile has been changed

emal experts imports

| oK || Cancel || Hep |

Do not overlook the “Confirm DLL function calls” option (which should be unchecked) -
otherwise the Forex Sensation will not be able to function properly.

You may also wish to uncheck “Disable experts when the account has been changed” and
“Disable experts when the profile has been changed” options, though this is more of a
convenience rather than a requirement. After you have checked all needed fields, click “OK”.
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5. Step 3: Attaching Forex Sensation to
a Chart

Having installed Forex Sensation, restart your MetaTrader4 platform and check the Navigator
panel on the left-hand side of the MetaTrader4 window. Clicking the small [+] to the left of
“Expert Advisors” will expand that section and change the [+] to a [-] toﬁplay all installed

products: ”

Mavigator x | Do not worry that the gerex Sensation icon is gray in this
---:f: Indicatars = | list, whilst all otheg icons are colored. This is normal for
-8 Expert Advisars all commercigl software. A colored icon means that you

grce code” for that particular file.

..... E CrisiskillerEURCHF_v1.3 have the “
..... % CrisisKillerGBPUSD_v1.3 ;

..... % CrisisKillerUSDCAD_ 1.3

m

_ (you cannot find the Forex Sensation icon on this list, it

----- = FarJRe*.-'-:uIutl-:unGBF‘USD*.-‘l.G/ ) ¢ bable that h installed it int

_____ % FapRevolutionUSDCADyL] !s mos pr_o able that you have installed it into an
incorrect directory. In that case, we would recommend

----- % FapTurbaoPremiups @heta
_____ ,% carefully going through step 1 of the installation process

..... % ForexSensationExtended again. Also, this happens very often when you have
..... & ForexStriker -~ | several MetaTraderd platforms installed on your
Common | Favorites | ] computer. Check the folders and reinstall it into the

correct folder. Or you might have simply forgotten to
restart your MetaTrader4.

2 Fle  View Inset Chats Tools )

- B~ ||&] & G L After you install all of the Forex Sensation files, and

USDCHF @ Eoa locate the Forex Sensation icon on the Navigator panel,

A GBPLUSD ] x| You need to open the chart with the feed necessary for
| EURUSD ! asx ~ | the Forex Sensation to trade. For Forex Sensation, it is

USDUPY | T the EURUSD chart. To open a new chart, simply click on

I n £/| “File” and select “New Chart”. You will then be
USDCAD prompted to select the desired currency pair in the

P| 133933 o
AUDUSD drop-down menu that will instantly appear. Select the

1 50,497
EURUSD chart.
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After opening the required chart (EURUSD), you need to select the M15 timeframe. To do this,
click on the chart, and then click on the M15 button in the top horizontal toolbar of your

MetaTrader4 window: /

M1 M5 | MIS M0 HI H4 D1 wil MM

After you have the necessary chart opened and the M15 timeframe selected, you can start
attaching it to the chart.

In this manual, we will explain how to attach Forex Sensation to the EURUSD chart.
Note: The Minimal Account Balance should be $1000 or more per currency pair

To attach the Forex Sensation to a currency chart: on the Navigator panel, right-click on the
Forex Sensation icon and select “Attach to a chart” in the menu as it is shown below:

Mavigator ® b GEPUSE
f Indicatars - - CEPLSD
- SE Expert Advisors ihll '“

..... F CrisisKillerEURCHF_v1.3 i

N S5 CrisisKillerGBPUSD_v1.3

m

----- risiskillerdsDCAD w13

Erter

Celete B

When you attach the Forex Sensation to the chart, the “Properties” dialog window will open.
The dialog window contains two tabs — “Common” and “Inputs”.
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The “Common” tab looks like this:

i )

ForexSensation @
Comman | |nputs

Comman
[Lcung & Short v] positions [¥] Allow DLL imports
Enable glerts [] Corfirm DLL function calls

Allow import of extemal experts

[C] Disable alert once hit

Live Trading
Allow live trading

[7] Ask manual confimation

[ OK ][ Cancel H Fesst

It is crucial that all three of the settings highlighted within the red frame are matching the
image above or Forex Sensation will not function properly.

Also, pay special attention to the “Confirm DLL function calls” checkbox which should be
unchecked. Assuming that everything else is correct, the “Inputs” tab looks like this:

L o

ForexSensation @
Inputs

Yarahle Walue

13

ab] v.1.00.4.82

ab | Code

%Y TesterGmtOffsst
(¥ Lots

% Riske

#| 51 true

m

ca [ == R = |
(%] - T3

| 52 true [ Load ]

s 53 true [

Save ]
B mm a

[ OK ][ Cancel H Fesst ]

If you scroll down this inputs section, you will be able to see a number of adjustable settings,
which are explained in the following several pages of the manual. If you wish to change any of
the settings, just double-click in the “Value” field of the desired setting, and enter the new
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value. To apply the changes, click OK, this will restart Forex Sensation with the new settings.
Remember to enter your Code (your license key) in the respective field.

Now we are ready to start trading.

Depending on how well you have followed our instructions so far, there will be one of three
possible things displayed in the top-right corner of the chart to which the Forex Sensation is
attached:

FotexSenssation (i raar
[ Smiley face indicates that the software is correctly installed and ready
to trade.
Fofesbensstion draar
[ %% _ X means that you forgot to enable the Expert Advisor trading in

MetaTrader4. Make sure that the big Expert Advisors button |$ e e

toolbar of MetaTrader4 is hit.

on the top

ForexSerszron(H] | _
}1.-:.44_ - Sad face indicates that you did not allow live trading. Just press F7 and

make sure that the “ALLOW LIVE TRADING” checkbox is checked!

L )

ForexSensation @
Comman | |nputs

Common Safety
[Lcung & Short v] positions [¥] Allow DLL imports
Enable alerts (] Corfirm DLL function calls

[F] Disable alert ance hit Allow import of extemal experts

Live Trading
Allow live trading

[7] Ask manual confimation

OK ][ Cancel H Fesst
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6. Forex Sensation Settings Explained

Code — This is your license number and it is used by the Forex Sensation to ensure that you are
not using a pirated copy of this product. You can find this code in the email message, which was
dispatched to you immediately after you made the purchase or withing the members area. It is
very important that you have a valid Code, as without this setting the Forex Sensation will not
be able to function at all.

TesterGmtOffset - the GMT offset which will be used during the robot’s backtest. The GMT
offset is detected automatically for live trading.

Lots - lot size which will be used for the trading if Risk is set to 0.

Risk - the risk setting determining the lot size with regard to the initial deposit. It is
recommended not to use a value higher than 0.5. The ultimate risk setting is 0.2. If you want to
trade fixed lots, set this setting to 0.

S1 - if set to “true”, the first strategy will be enabled. The strategy is based on an algoritm
searching for a pattern correction. The market entry is done in the direction of a more global
trend, at a price rollback (correction).

S2 -if set to “true”, the second strategy will be enabled. The strategy follows a trend. When the
market movement gains a rather strong traction, a trade is placed in the direction of the trend.

S3 - if set to “true”, the third strategy will be enabled. The strategy trades at the most volatile
time of the day placing a trade in the direction of an impulse.

S3_Aggressive - the third strategy’s aggressive mode. If the aggressive mode is enabled, the
strategy uses fewer filters, so a trade opens almost daily. If the aggressive mode is disabled, the
strategy uses more sophisticated market entry rules that increase the trading’s precision yet
decrease the number of trades. For safe trading we recommend to keep this setting disabled.

S4 - if set to “true”, the fourth strategy will be enabled. Strategy follows a trend after important
news releases.

MaxSpread - maximal spread with which the trading is allowed.
S1_Magic - the first strategy’s magic number.
S$2_Magic - the second strategy’s magic number.

S$3_Magic - the third strategy’s magic number.
S4_Magic - the fourth strategy’s magic number.
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7. Forex Sensation On-chart Messages

If you installed the Forex Sensation correctly, the following on-chart message should
automatically appear in the top left part of your chart:

w EURUSD,M15 1,35065 1.35102 1,34982 1,35002

The version number displayed and the general content above will change over time as new
versions are released and additional features are incorporated.

Authentication status: This message should display “Authenticated” if the software has
verified the Code successfully and is functioning properly.

Members Area Account: This message should display your members area account login
(email).

ServerTime: Current time on your broker’s server.
UtcTime: Calculated UTC time.

Spread: Current spread for both 4-digit and 5 digit quotes.
Leverage: Your account leverage.

Lot: Displays the lot size of the next trade that will be opened.
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8. Forex Sensation Strategy Test

If you want to do the strategy testing of the Forex Sensation, you will need to have the
historical data.
Now let’s learn how to make a backtest with the My FX Choice broker.

1. Open the FX Choice MetaTrader 4.

2. Go to “Tools > History Center” then DOUBLE-Click EURUSD under the “Majors-var” list,
click 1 Minute(M), then click “Download” to begin downloading historical data.

History Center: EURUSD, M1 (-7 | [=23a]
Symbols; Database: 2097 records
7] MetaTrader 4 'S Time Open High Low Close Volume =
=
9"' Majors-var (1 2012.02.28 00:37 1.33921 1.33949 1.33919 1.33940 EE
=--[%] EURUSD
= [ 2012.02.28 00:36 1,33938 1,33933 1,33921 1,33921 56
=1 1 Minute (M1)
5 Minutes (M5) [J 2012.02.28 00:35 1.33932 1.33944 1.33931 1.33933 a0
63 15 Minutes (M15) [) 2012.02.25 00:34 1,33927 1,33946 1,33927 1,33933 97
30 Minutes (M30) [) 2012.02.28 00:33 1,33925 1.33942 1.33925 1,33928 &5
1 Hour (H1) ) 2012.02.28 00:32 1.33917 1.33929 1.33917 1.33922 91
4 Hours (H4) _|| | @ 2012.02.28 00:31 1,33920 1,33320 1.33916 1.33917 11
Daily (D1) T | O 2012.02.28 00:30 1.33917 1.33920 1.33908 1.33920 50
Weekly (W) [ 2012.02.28 00:29 1.33912 1.33928 1.33906 1.33918 52
-1 Monthly {(MN) @ 2012.02.28 00:23 1.33914 1.33914 1.33910 1.33913 12
|| GBPUSD
— @ 2012.02.28 00:27 1,33918 1.33937 1.33915 1.33917 37
| %] USDCHF
B uFY @ 2012.02.28 00:26 1.33929 1.33929 1.33917 1.33917 41
-8 Minors-var [J 2012.02.28 00:25 1,33925 1.33932 1,.33915 133931 55
G-f2) Commodities-var [) 2012.02.25 00:24 1.33923 1,33927 1,33923 1,33926 E;
G- {8 Crosses-var ~ | | @ 2012.02.28 00:23 1.33929 133930 1.33922 1,33923 bl
G- @) Scandies-var ) 2012.02.28 00:22 1.33918 1.33934 1.33917 1.33928 59
= .
(#1-(8) Exotics-var [J 2012.02.28 00:21 1.33914 1.33919 1.33910 1.33817 39
&8 Enariae bl B i
[ Download l ’ Add l ’ Edit l ’ Delete ] ’ Export ] [ Import l [ Close

DONE! Now it is time to do the backtest!
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Click the Strategy Tester button in the MetaTrader4 toolbar to open the window.

T % e i M1 |mMs mis m30 HLOF

The Strategy Tester will appear at the bottom of MetaTrader4.

Expert Advisor: [ForexSensation. Copyright © 2013, Forex Sensation Championship V]
Symbol: [EURUSD, euro vs US dollar - Peried:
Model: [Everytick fthe most precise method based on all available least timeframes to generate eachtick) - Spread: Cumert -
Use date [+ Fom: 2013.0201 To: 2113.1015 Optimization
Visual mode Skip to 2013.10.15

Expert properties
Symbol properties
Open chart

Modify expert

Start

Tester

Settings | Journal |

You should select Forex Sensation from the list, the proper symbol (EURUSD), the M15 period

(timeframe). Choose the “Every Tick” model.
Also set “Use Date” to test over a specific period in the past.

We recommend you not to use the “Visual mode” for long time spans because the backtest will
take much more time, but you will see a simulation of the trades being made on the currency

chart.

Important: To perform a backtest correctly, you need to specify the brokerage’s GmtOffset
value manually in the Expert Properties menu as it is shown below. The GmtOffset for My Fx
Choice on backtests is “1”, so you need to change it from 0 to 1 in the TesterGmtOffset field.

Note: You can ask you broker for the backtest GMToffseyf coz it’s usually different from live

trading GMTOffset.
013.01.0112:00 | FX Choice Limited | ForexSensation | ]
013.01.01 12:00 FX Choice Limited
— [ Testing | Inputs | Optimization |
013.01.01 12:00 FX Choice Limited y 4
de | AccountHistory | Mews | Alerts ariable Walue Start Step Stop

¥ v.1.00.4.82

Expert Advisor: | ForexSensation, Copy] I Cods : = -

Expert properties

Symbol properties

Model: | Every tick {the most pr I Lets o - - Open chart
[ Risk 0.2 0 0
lUse date |w From: 51 btion Modify expert
Visual mode T 52 .
[ Load ] [ Save ] Start
tings | Journal |
[ OK ] [ Cancel ] [ Reset ]

. press F1 i 10658/1 kb

Click START to begin the test.
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You may switch between the various tabs at the bottom of the Strategy Tester window during

the testing.

You can see the trades here:

x[# | Time | Type | Crder | Size Price | siL) 1/p] Profit | Balance:
@ 25 2009.01,14 092:59 tp 1] 0.30 1.11983 1.10063 1.11963 8086 9970.91
@ 26 2009.01.14 10:00 close 7 0.30 1.11970 1.10113 1.12013 58.14 10029.05
@ 27 2009.01.14 10:00 tp 5 0.30 1.12013 1.10113 112013 69.62 10098.67
[B 28 2009.01,14 16:45 by 10 0.31 1.11863
D 29 2009.01.14 16:45 modify 1n 0.31 1.11663 1.10023 1.11923
@ 30 2009.01.14 17:09 tp 10 0.31 1.11923 1.10023 1.11923 72,01 10170.68
D 31 2009.01.14 20:15 buy 11 0.31 1.11623

bl
Bl Settings | Resuts [ Graph | Report | Journal |

You can learn the detailed information about the current backtest in the “Report” Tab.
Right-clicking in this window and selecting “Save as report” will create a detailed report of your

testing.
Bars in kest 36508 Ticks modeled 15365319 Modelling quality 90.00%: *
Mismatched charts errors i} I |
Initial deposit 1000000
Total net profit 27463.04 Gross profit 29090.32 Gross loss -1627.729
Prafit Factor 17.88 Expected payoff 122,60
Absolute drawdown 865,10 taximal drawdown 3546.27 {10.40%) Relative drawdown 15.56% (1907.33)
Total trades 274 Short positions (won %) 105 (94.29%:) Long positions {won %) 119 (95.80%)

Profit trades (% of total) 213 (95.09%)

Lass trades (% of ktatal) 11 (4.919%) _I
=

Settings | Resulks | @Graph | Report | Journal |

If your Strategy Test showed no trades, it means there were some errors. Check the Journal Tab

to discover the problem.
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9. Troubleshooting Q&A

Q. Forex Sensation is not working, what should | do?

A. First of all, please, make sure that all installation steps from the manual were performed
correctly. If you did not locate any errors in the installation process, have a look under the
“Experts” and “Journal” tabs in the “Terminal” window of your MetaTrader4 to identify your
problem.

Q. I'm getting the error message “DLL calls are not allowed” what should | do?

A. Please, make sure that under the Tools->Options->Expert advisors tab of your MetaTrader4
platform the “Allow DLL imports” box is checked. If not, check it, confirm changes, and reattach
the Forex Sensation to the chart. Also, make sure that “Allow live trading” is checked and
“Confirm DLL function calls” is unchecked, as these settings are also crucial for the Forex
Sensation’s trading.

Q. I’'m getting the error message “You've entered wrong Code” what should | do?

A. This means you have forgotten to enter your authentication code or you’ve entered wrong
Code. Click the smiley face icon or press F7 to open the Inputs tab and enter the correct code.

A. What if I'm getting other errors?

If you are experiencing any issues that are not covered in the knowledgebase or the user’s
manual, please submit a support ticket providing as much detail as possible. Any screenshots or
additional information will be appreciated.
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10. How to Stop Trading

There are several ways to stop the software’s trading.

1) In case you use several products on your account and want to completely stop the
trading of them all, click the green “Expert Advisors” button in the toolbar. Please, bear
in mind that this action will also stop any other products that you may be running on
your account.

% Expert Advisors

2) If you want to remove only one product, you can do so by right-clicking on the Smiley
Face and choosing “REMOVE” in the menu.

Expert Advizors F¥

Periodicity

Template L ’D" Strateqy Tester FB

Refrezh

Auto Arrange Ctrl+ts
Grid Chrl+(3

3) If you don’t want to remove the software, you can simply disable its live trading ability
by pressing F7 and un-checking the “Allow live trading” checkbox:

ForexSenszation @
Common | jnputs

Common Safety

-

|L|:|ng & Short v| positions o | Allow DLL imports

7| Enable alerts Corfimn DLL function calls

| Allow import of extemal experts
Disable alert once hit ow Impa Smal &pe

Live Trading

| Allow live trading

Ask manual confimation

QK ]| Cancel || Feset
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